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Exercise 1 – Establishing Spatial Reference  


 
 
 
Session Objectives:  At the conclusion of this session, you will be able to: 
 
 


 
 Assign a coordinate system to an ArcMap data frame 


 
 Define and transform datum’s and coordinate systems for vector and raster 


datasets 
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Material Created By:  Todd Sutherland (December 2005) 


Revision: Eric Kelchlin (October 2013) 


Software:  ArcGIS 10 SP5 


Directory Path: C:\ or D:\CSP7200\Exercise1 


Shapefiles: mn_wpas_albers, mn_cnties_utm.shp, p8_brdsrvy.shp, p8_landcov.shp 


Imagery: p08_doq.sid 
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SECTION 1 – Assign a Coordinate System to a Data Frame 


 
Unless stated otherwise, all data are located in CSP7200\Exercise1. 


  


1. Launch ArcMap  and open a New Blank Map. 
 


 
 
 


2. Right-click on the Layers data frame and select Properties.  Click on the 
Coordinate System tab.  By default, no coordinate system is assigned to the 
data frame.  Click OK to close the dialog. 
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3. Add   the wpa_albers.shp layer.  This layer has a projection file (.prj) and 
therefore the data frame will assume the projection. 
 


4. Check the data from properties again.  What coordinate system is the data frame 
now_____________________________? 
 
When adding multiple layers at the same time, ArcMap uses the last layer you 
select to set the data frame’s coordinate system. 
 


5. Add  the counties_utm.shp layer.  You should get a warning “Unknown 
Spatial Reference”.  This layer does not have an associated .prj file. 


 


 
 


This warning does not always appear when adding layers that lack spatial 
reference information.  Hence, it is very important that you always define the 
spatial reference of your layers.  This is vital for shapefiles! 
 


6. Click Full Extent  on the Tools toolbar.  These 2 layers do not overly even 
though both represent features in Minnesota.  The counties_utm layer does not 
have a projection file, therefore Arcmap cannot determine its coordinate system.  
If this layer had this valuable information, then ArcMap could perform an “on-the-
fly projection”.  These two layers would then be aligned in the same coordinate 
space. 
 


7. The native projection for this layer is UTM-Zone 15, NAD83.  So, let’s assign this 
coordinate system to the data frame to get these two layers to line-up. 
 


8. Right-click on the Layers data frame and select Properties.  Select the 
Coordinate Systems tab. 
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9. In the Select a coordinate system section, navigate through the Predefined > 
Projected Coordinate Systems > UTM > NAD 1983 folders and select NAD83 
UTM Zone 15N.  Click OK. 
  


 
 


 
 


10. Click Full Extent  on the Tools toolbar.  Drag the wpa_albers layer on top of 
the counties_utm layer in the Table of Contents. 
 


11. The two layers now overly correctly because the wpa_albers file, which has an 
associated projection file, is projected on the fly from Albers to UTM by ArcMap. 
 


12. Is this the best approach for dealing with this issue?  Why or why 


not______________________________________________________________


_______________________________________________________________? 


 


13. Close  ArcMap.   Do not save changes. 
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SECTION 2 – Using the Define Projection Tool 
 
In this section you will define a projection for the counties_utm.shp file.  For 
shapefiles, defining a projection means that you will be creating a .prj file. 
 


1. Launch ArcCatalog  from the desktop.   
 


2. Right-click on the counties_utm layer in your catalog tree and select 
Properties.  Click on the XY Coordinate System tab and notice how the 
coordinate system is unknown.  Select OK to close the dialog. 
 


 
3. Open ArcToolbox   if it’s not already docked on the right side of your screen. 


 
4. Find the Data Management Tools > Projections and Transformations toolbox 


and double-click on the Define Projection tool. 
 


 
 


5. Navigate to the counties_utm layer and select the properties  icon.  Click 
on the  button and browse to through the Projected Coordinate 
System folders and select the appropriate coordinate system as shown 
below.  Click OK when done.   
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6. Right-click on the counties_utm layer in the catalog tree to see that the 


Coordinate System was assigned correctly. 
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SECTION 3 – Using the Project Tool to Change the Spatial Reference 
 
ArcMap’s on-the-fly projection should only be used for display purposes.  The 
recommended approach is to ensure that all GIS layers have the same spatial reference 
to avoid errors in spatial analyses.  In this section you will change the projection of the 
wpa_albers.shp layer to match the counties_utm.shp layer. 
 


1. In ArcToolbox, navigate to the Data Management Tools > Projections and 
Transformations > Feature toolbox and double-click on the Project tool. 
 


 
 


2. Fill-in the fields as shown below.  Name the layer wpa_utm and save in the 
same folder.  Click OK when done. 
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SECTION 4 – Surviving a Datum Shift 
 
This section demonstrates how one can obtain inaccurate results when conducting 
spatial analyses using layers that are NOT referencing the same spatial reference 
system.  This could easily happen if you have not assigned spatial reference information 
to your files.   
 


1. Close  ArcCatalog and launch ArcMap . 
 


2. Open a New Blank Map and Add  the bird_survey.shp and landcover.shp 
layers.  Click OK at the Unknown Spatial Reference warning dialog if it appears. 
 


3. Notice that both layers appear to align, but if you open the Properties > Source 
tab in the bird_survey layer you’ll see that this layers coordinate system is 
undefined.   
 


4. What’s the coordinate system for the landcover layer_____________________? 
 
A novice user may believe that these layers are using the same coordinate 
system since they both overlay.  They both do in fact use the same map 
projection (UTM Zone 15), but different datums.  Therefore, these 2 layers are 
not using the same spatial reference system. 
 
In Minnesota, the difference between NAD27 and NAD83 coordinates is 
approximately 15 meters for the X value and -213 meters for the Y value.  This 
amount of positional error will cause inaccurate results when performing spatial 
analyses.  To demonstrate this fact, we are simply going to pretend everything is 
OK and conduct our spatial analysis. 
 


5. For our analysis we want to identify all the habitat types that contained greater 
than 5 American Redstart observations in Pool 8 during the 1996 survey. 
 
From the Selection menu, choose Select By Attributes and create a query for 
greater than 5 American Redstarts (code = NAMRE) in the bird_survey layer. 
 


 
 


6. Click Apply and close the Select By Attributes dialog. 
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7. Click on the Selection menu again, but this time choose Select By Location.  
We want to select features from the landcover layer that intersect with the 
selected features of the bird_survey layer. See the example below. 
 


 
 


8. Click Apply and close the Select By Location dialog. 
 


9. Click on the List by Selection icon in the table of contents.   
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10. Right-click on the landcover layer and Open the Attribute table.  Right-click on 
the LCU field and choose Summarize.   
 


11. Just make sure the output is going to your Exercise1 folder.  Click OK. 
 


 
 


12. Click on the List by Source icon.  Right-click on the results table select Open. 
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13. Right-click on the Count_LCU field and select Sort Descending.  What are the 
top three land cover types and what is the count for each? 
 
___________________ ____ 
 
___________________ ____ 
 
___________________ ____ 
 


14. Clear the selected features by clicking on the Clear Selection tool. 
 


 
 
 


Next we are going to perform the same summary as above, but this time transform the 
bird_survey layer to the same datum as the landcover layer.  Before we can do this 
however, we need to examine the metadata and write down the datum and coordinate 
system. 


 
15. Right-click on the bird_survey layer in the table of contents and select Data > 


View Item Description.  To view the datum and coordinate system simply scroll 
down and select the ArcGIS Metadata > Reference System section.  What is 
the answer? 
 
________________________. 
 


16. Next, use the Project tool in ArcToolbox to define the appropriate projection to 
the bird_survey layer.  A quick way to find the tool is simply use the Search tool 


 located on the Standard toolbar or docked at the right side of the screen.   
 
 


17. Select Tools, search for “Project”.  Click the Project (Data Management) item 
on the list to activate the tool. 
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18. Populate the fields as shown below.  Name the output file bird_survey_NAD83 
and save in the Exercise1 folder.  Since the input and output coordinate systems 
use two different datums, we must select a Geographic Transformation. Click OK 
when done. 
 


 
 
 


19. Your new layer will be added at the top of your table of contents.  If you receive 
an error, refresh the active view and try again. 
 
 


20. Remove the old bird_survey layer and perform the analysis again using the 
bird_survey_NAD83 layer.  What are your answers this time? 


 
___________________ ____ 
 
___________________ ____ 
 
___________________ ____ 
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TIP: Unlike shapefiles, geodatabases require you to assign a spatial reference to all 
your layers (known as feature classes in a geodatabase) because a geodatabase has 
integrity and rules that must be followed.  Shapefiles are angry stepchildren with bad 
habits and short memories.  So, choose the right data type for your next GIS project. 
 
 
SECTION 5 – Transforming and Projecting Raster Datasets 
 


1. Clear all selected features and add  the Mn_Imagery.sid raster layer. 
 


2. Notice the Geographic Coordinate Systems Warning dialog appears.  You are 
informed that the layer you just added uses a different geographic coordinate 
system (datum) than the exiting map data or data frame.  It also suggest that you 
may need to choose a different geographic transformation.  It is very important to 
understand what is going on here.  ArcMap warns you of this issue because 
there are several datum transformation methods that could be used and ArcMap 
has automatically selected one for you. 
 


3. Click the  button and verify that the fields match those shown 
below.  Click Close when done. 
 
The image has been on-the-fly projected; the spatial reference information is not 
permanently changed.  This is really just for background use only, not analyses. 
 


 
 
 


4. To permanently change the spatial reference information, first remove the 
Mn_Image layer from the table of contents.  
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5. Use the Search tool  to find the Project Raster tool in ArcToolbox.  Click on 


Project Raster (Data Management) item to activate the tool. 
 


6. Make sure the fields match those as shown below.  Rename the image 
Mn_Image83 and save it in the Exercise1 folder.  Note:  the raster file name 
cannot be longer than 11 characters. 
 


 
 


 
7. Click OK.  The process will take a couple minutes to complete.  Once done, the 


image will automatically appear in your table of contents. 
 


8. Verify that the projection is correct by looking at the metadata as we did 
previously, or by simply right-clicking on the image layer and viewing the Source 
information. 
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9. Close ArcMap.  Do not save your document. 
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Exercise 2 – Acquiring Spatial Data Online 
  
 
 
Session Objectives:  At the conclusion of this session, you will be able to: 
 


 
 


 
 Identify online sources to obtain GIS Data 


 
 Download imagery using Earth Explorer 
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Material Created By:  Eric Kelchlin (October 2013) 


Software:  ArcGIS 10, SP5 


Directory Path: C:\ or D:\CSP7200\Exercise2 


GDB:   
Imagery:  
MXD: 
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Searching the internet for GIS data is easy, but don’t let the cart get before the horse.  
First make a list of what data sets or imagery you need and then perform the search.  
It’s easy to fill-up hard drives with gigabytes data that are rarely used because the 
resolution is too coarse (i.e.  You found a 30 meter DEM, but needed 3 meter for the 
analyses) or the data quality is unknown (i.e. no metadata).   
 
There are many websites to obtain free GIS data for the United States, but very few that 
cover the geographical extent of the Maldives.  This is especially true if you’re looking 
for fine resolution raster and vector data sets.  If you can’t find anything useful on the 
web, another option is to check with your local cooperating agencies to see if they have 
acquired GIS data for internal projects.  You could find a wealth of useful data.  If this 
fails, then you will need to 1) purchase the data from a vendor if it already exists, 2) hire 
a vendor to create the data if none exists or 3) create the data yourself via heads-up 
digitizing or field mapping with GPS units. 
 
 
All data are located in CSP7200\Exercise2, unless otherwise stated. 
 
This exercise shows you how to obtain free imagery from EarthExplorer, which is 
managed by U.S. Geological Survey (USGS).  EarthExplorer has a simple interface and 
the largest collection of free downloadable GIS datasets.  
 
 
TASK 1 – Explore the Available Data Types 
 


1. Launch a web browser and navigate to the USGS products overview page.  
 
https://lta.cr.usgs.gov/products_overview 
 


2. Take 10 minutes and explore the available data types, but don’t go to the 
associated links just yet. 
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TASK 2 – Download Landsat 8 Satellite Imagery 
 


1. Select the Landsat Satellite Archives data type and click on the EarthExplorer 
link for Landsat 8 OLI. 
 


 
 
2. Login to the site using the following credentials listed below.  You can create 


your own login later if you wish, but I’ve created one for the class to use. 
 


User name:  veg mapping 
Password:  nctc2013 
 


 
 


3. Locate the Maldives on the map and add a marker on the Island of Male.  To 
pan, simply hold down the left mouse button and move the mouse.  To zoom-
in, scroll forward on your mouse.  To add a marker, simple left-click on Male. 
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4. Click on the Data Sets button  on the bottom left of the dialog. 
 


5. Maximize the Landsat Archive data set and check the L8 OLI/TIRS box.  
Click on the identity symbol  to learn more about the Landsat 8. 


 


6. Select the Results button  to see what’s available for our location 
of interest. 


 
7. Select the download button for the first scene. 
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8. Select the download option shown below.  This will give us a natural color 
image that has been projected.   
 


 
 


9. Click on the Select Download Option button and Download again.  
 


10. Save the zip file in your Downloads folder.  
 


11. Extract the files and save them the Exercise2 folder. 
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12. Open ArcMap and view the data.  Do you think this data is useful if the 
purpose was to overlay GPS data?  What do you think you could use this 
imagery for? 
 


TASK 3 – Search and Download Other Data Types from EarthExplorer  
 


1. Go back to EarthExplorer, search for and download other data types that may 
be useful for your GIS needs. 
 


NOTE: EarthExplorer provides other ways to identify the search area in addition 
to using a single point/coordinate on the map. 
 


1. You can use Path and Row to find more Landsat 8 data.  The KML file 
of the path/row data can be downloaded 
here: http://landsat.usgs.gov/tools_wrs-2_shapefile.php or found in the 
Exercise 2 folder already, 
 


2. Add a shapefile or KML file to define the area, 
 


3. Or click Use Map to assign the extent as the search area. 
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Links to Learn More About Landsat 8 Satellite Imagery 
 


Good introduction to Landsat 8 - http://www.shadedrelief.com/landsat8/introduction.html 
  
Everything Landsat - http://landsat.usgs.gov/index.php 
 
Landsat 8 band combinations (ESRI) -
 http://blogs.esri.com/esri/arcgis/2013/07/24/band-combinations-for-landsat-8/  
 
Landsat 8 product descriptions -  http://landsat.usgs.gov/documents/LDCM-DFCB-
004.pdf  
 
 
Global GIS Data Sources 
 
Cornell University - http://mannlib.cornell.edu/research-help/gis/gis-data  
 
Global Coral Reef Data and Resources - http://www.reefbase.org/main.aspx 
(registration required) 
 
NASA Earth Data - https://earthdata.nasa.gov 
 
SRTM DEM data -  http://srtm.csi.cgiar.org/ 
 
Geodata Platform - https://www.geoplatform.gov/  
 
Geocommons - http://geocommons.com/  
 
DataBasin - http://databasin.org/  
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Exercise 3 - Geodatabase Design for Legacy Data  
 


Session Objectives:  At the conclusion of this session, you will be able to: 


 


 Create a file geodatabase with a thematic structure. 
 


 Convert a mess of shapefiles and miscellaneous datasets into a clean and smart 
file geodatabase. 
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Material Created By:  Eric Kelchlin (Oct 2011) 


Revision:  November 2013 


Software: ArcGIS 10, SP 5 


Data Path: C:\ or D:\CSP7200\Exercise3 


Databases: NCTC.gdb (student creates) 
 
Imagery: Imagery\Aerial_2009.sid 
 
MXD:   
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SECTION 1 – Managing Legacy Data with a File Geodatabase 


This section demonstrates how to use tools in ArcCatalog to convert a mess of 
shapefiles and other datasets into a clean and smart geodatabase.  The first step is to 
examine your data layers and group similar items (i.e. shapefile layers) into file folders.  
These folders can become your feature datasets and thereby structure your 
geodatabase.  The structure can be thematic (i.e. theme based), geographical, project 
specific or a combination of all three.  You can have one geodatabase or many; this will 
depend on how much data you have and also on your project objectives and office 
organizational requirements. 


When you create the feature datasets you will also have to decide on a datum and 
projection.  You can assign different spatial references for the feature datasets within 
the same geodatabase, but this is best done for geographically based designs.  
Thematic designs will typically have the same datum and projection for the data layers 
in the geodatabase. 


Once you have a geodatabase with a structure of empty feature datasets, the next step 
is to create feature classes from your legacy data.  This is your opportunity to delete 
duplicate layers and messy data without metadata.  The data clean-up and compilation 
efforts can be done as part of the data import/loading process while creating new 
feature classes. 


 
All data are located in the CSP7200\Exercise3 folder, unless otherwise stated.   
 


TASK 1 – Create a File Geodatabase with a Thematic Structure 


1. Open ArcCatalog. 
 


2. Connect to the CSP7200 folder by clicking on the Connect to Folder tool and 
navigating the folder.   All of your class exercises reside in this folder. 
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3. Create a new file geodatabase in the Exercise3 folder by simply right-clicking on 
the folder, choose New > File Geodatabase. 
 


4. Name the geodatabase “NCTC” and hit enter on your keyboard.  A new file 
geodatabase has been created.   
 


5. Next, create a new feature dataset that will store our feature classes.  Right-click 
the NCTC geodatabase and select New > Feature Dataset. 
 


6. Name the feature dataset Boundary.  Click Next . 
 


7. We need to assign a coordinate system for the feature dataset.  Select 
Projected Coordinate System > UTM > NAD 1983 > UTM Zone 18N for the 
coordinate system.  This is the standard projection used at NCTC.  Click Next. 
 


 
 
 


8. Click Next in the vertical coordinate system dialog, you won’t need to define this 
in most situations. 
 


9. In the next dialog, keep the default tolerances and click Finish. Notice how the 
feature dataset is added below the NCTC geodatabase. 
 


10. Create another feature dataset, however, since we are using the same 
coordinate system for all feature datasets, simply right-click on the Boundary 
feature dataset and select Copy. 
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11. Next, right-click on the NCTC geodatabase and select Paste.  Click OK at the 
data transfer dialog.   
 


12. Rename the feature class by simply right-clicking on the Boundary_1 feature 
class and selecting Rename.  Rename it to Hydrology.  This technique can be 
quite the time saver. 
 


13. Create two more feature datasets using the same methodology.  Name the first 
“Transportation” and the other “Monitoring”.  


 


14. Can you think of any other feature datasets that would help organize your GIS 
data at your office? 
 


_____________________________ 


_____________________________ 


_____________________________ 


_____________________________ 


_____________________________ 
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TASK 2 – Creating a New Feature Class from an Old Shapefile 


1. Right-click on the Boundary feature dataset.  Select Import > Feature Class 
(single…). 
 


2. For Input Features, click the browse folder  button and navigate to the 
Exercise3 folder.  Choose the Boundary.shp file and click the Add 
button. 
 


3. Type ”ntc_boundary “ in the Output Feature Class field.  Click OK. 
 


 
 
 


4. Expand the Boundary feature dataset and select the new feature class.  Click on 
the Preview tab to view the new feature class you just imported. 
 


5. Change the Preview field from Geography to Table.  What two land status 
attributes are listed in the table?  ________ and _________. 
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6. On the main toolbar, click Customize > ArcCatalog Options and make sure 
your metadata style is FGDC CSDGM Metadata.  This is short for the Federal 
Geographic Data Committee Content Standard for Digital Geospatial Metadata. 
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7. Click on the Description Tab to view the metadata.  Search through the 
metadata and find what these two attributes indicate.  
 


 
 
 


8. What does the coded “o” and “a” status attributes refer to? 
 
 ______________________  
  
 ______________________ 
 
 


  


Legacy Data                                                                                      8 







GIS Data Development and Management                                                                              2014 
U.S. Fish and Wildlife Service                         National Conservation Training Center 
 
TASK 3 – Creating Multiple Feature Classes from Multiple Shapefiles 


1. Next, let’s bring in a batch of shapefiles all at once to save time.  Right-click on 
the Hydrology feature dataset and select Import > Feature Class (multiple…). 
 


2. Click the browse folder  button and navigate to the Exercise3 folder.  Hold 
down the Ctrl Key and select the Ponds, Ponds_27, Springs, Streams and 
Watershed shapefiles.  Click  Add and OK. 
 


 
 


3. Examine the spatial reference for the NEW Ponds_27 feature classes by right-
clicking on each feature class and selecting Properties, then clicking on the XY 
Coordinates Tab.  What are the XY Coordinates for these layers? 


 Ponds feature class:_______________________ 


 Ponds_27 feature class:____________________ 


 
4. Do the same for the Hydrology feature dataset.  The XY Coordinates should be 


the same as your feature classes. 
 


5. Now, examine XY Coordinates on the OLD Ponds and Ponds_27 shapefiles.  
What are the XY Coordinates for these layers? 
 
Ponds shapefile:___________________Ponds_27 shapefile:________________ 
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6. Click on the   button on the main toolbar in ArcCatalog to launch ArcMap and 
examine your new feature classes.   
 


7. Click on New Maps in the ArcMap Getting Started dialog.  Change your default 
geodatabase to NCTC and click OK.  
 


 
 
 


8. Add  the Aerial_2009.sid file from the Imagery folder.   
 


9. Add  the Ponds and Ponds_27 feature classes. 
 


10. Do the ponds overlay correctly or is there a shift?______________. 
 


11. If the shapefile has an undefined coordinate system (i.e., does not have an 
associated projection .prj file) the shapefile will be imported into the feature 
dataset and assume what?_________________________________.   
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The point here is that you need to have a projection defined for all your 
shapefiles before you perform a multiple/batch import.  The Ponds_27 shapefile 
was actually digitized in the NAD27 datum, not NAD83.   
 
The geodatabase will assign each imported layer whatever you have defined in 
the feature dataset, which can lead to large spatial errors.  It does not matter 
what projection you have for the shapefile, just as long as you have one.  The 
geodatabase will automatically transform the data into the spatial reference you 
have in the feature dataset.  
 


TASK 4 – Importing XY Tabular Data 


This example shows you how easy it is to take an Excel spreadsheet containing XY 
coordinate data and create a new feature class.  


 
1. Maximize the NCTC.xlsx file in the Catalog Tree and highlight the 


NCTC_Signs$ worksheet.  The $ symbol indicates that it’s an excel worksheet. 
 


2. Look at the table in the Preview tab and notice that we already have a UTM_X 
and UTM_Y coordinate fields and we also know the datum and coordinate 
system. 
 


 
 


3. Right-click on NCTC_Signs$ worksheet and select Create Feature Class > 
From XY Table… 
 


4. Change the Y Field to UTM-Y. 
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5. You can chose to leave the Z Field blank or change it to the Altitude field.  If you 
change it to Altitude you’ll have a Point Z data type which is used for 3 
dimensional data viewing. 
 


6. Click on the browse button  in the output section and save your new feature 
class as ntc_signs in the Monitoring feature dataset.  Make sure to change the 
file type to “File and Personal Geodatabase feature classes”.  Click Save, then 
OK. 
 


 
 


 
7. Peruse your geodatabase.  Was ntc_signs added to the Monitoring feature 


dataset__________?  This is a strange quirk.  Use your mouse to drag and drop 
your new feature class into the Monitoring feature class. 
 


8. Right-click on the ntc_signs feature class and select Properties.  Click on the XY 
Coordinate System tab and notice that the proper datum and coordinate system 
was applied to the data. 
 


9. Repeat the same table to feature class process, but this time save the feature 
class inside the geodatabase, not inside any feature dataset.  Use a different file 
name.  Look at the XY Coordinate System for this second feature class. Is it 
defined_______?   
 


10. How would you define the XY Coordinate System of a table during table to 
feature class process if you’re not saving it into a feature dataset? 
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TASK 5 – Performing SQL Queries while Importing Shapefiles 


Let’s import another shapefile into the NCTC geodatabase, but this time we’re going to 
clean-up the data during the import with an SQL query. 


1. Close ArcMap if you have not done so already. 
 


2. Right-click on the Transportation feature dataset and select Import > Feature 
Class (single…).  Input the trails_GPS_2008 shapefile. 
 


3. Name the new feature class ntc_trails.  Continue onto the next step before 
finishing. 
 


4. Click the SQL   button to create a query. 
 


 
 


5. Create the query to include all the trails except Deer Stand Trails as shown 
below.  The instructor will walk you through this part.  Click OK when done to 
return to the previous screen. 
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6. Let’s clean-up the data a bit more before we finish the import.  Delete the last 5 
fields in the Field Map section using the delete button.  Click OK. 
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7. Look at the Table in the Preview tab to make sure the data was imported 
correctly. 
 


 
 


8. Repeat the same process above, but this time only import the Deer Stand Trails.  
Name the new feature class ntc_deer_stand_trails.   


 


TASK 6– Importing a Feature Class  


We’re almost done.  Let’s import one more data type; a feature class from a file 
geodatabase.   
 


1. Right-click on the Transportation feature dataset and select Import > Feature 
Class (single…). 
 


2. For Input Features, click the browse  button and navigate to the 
Deer_Project geodatabase. 
 


3. Select the ntc_hunter_parking feature class from the Deer_Hunt feature 
dataset.  Click the Add button. 
 


4. Name the Output Feature Class ntc_hunter_parking.  Click OK when done.  
 


5. Click on the Preview tab and examine the data you just imported. 
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TASK 7– Appending Data using the Load Command 


This is an example where we mapped hunter parking lots on two separate occasions 
using different GPS units.  We now have to do some data management to append the 
new data to our existing ntc_hunter_parking feature class.  The Load command allows 
you to append data if the source schema differs, which is the case here.  The Append 
tool in ArcToolbox can be used if the data have the same schema. 


 


1. Right-click on the ntc_hunter_parking feature class you just imported.  Choose 
Load > Load Data.  Click Next on the first screen that appears. 
 


2. For input data, click browse  and navigate to the Deer_Project geodatabase 
in the Project folder.  Select the hunter_parking feature class. 
 


3. From the Simple Data Loader dialog, click Add to include the data in the List of 
source data to load field.  Click Next twice. 
 


 
 


4. Click on the drop-down arrows for the <none> values in the Matching Source 
Field column and match-up the Source with the Target fields.  Note: any 
unmatched fields will be null in the appended records.  Click Next. 
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5. Now, the important part.  We need to create a simple query to select only the 
records we want appended to our existing feature class.  Ensure that the “Load 
only the features that satisfy a query” is checked. 


 


6. Click the Query Builder button and select only values that = 1 in the chgcode 
field.  Do you remember how to do this?   
 


7. Preview the ntc_hunter_parking feature class tabular data when done to make 
sure the records were appended. 


 


Congratulations!  You imported shapefiles, tables and future classes into your 
new file geodatabase. 
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Exercise 4 - Geodatabase Design for Project Specific Data 
Collection  


 


Session Objectives:  At the conclusion of this session, you will be able to: 


 


 Create a project specific geodatabase using a structured framework. 
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Material Created By:  Eric Kelchlin (Oct 2011) 


Revision:  November 2013 


Software: ArcGIS 10, SP 5 


Data Path: C:\ or D:\CSP7200\Exercise4 


Databases:  
 
Imagery: Imagery\Aerial_2009.sid 
 
MXD:   
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SECTION 1 – Designing a New Geodatabase for a Specific Project 


 


Please read the project summary below first! 


 


Title: Invasive Plant Inventory 


Contact Information:  Phil Pannill; Land Manager at NCTC  


Problem Statement:  


NCTC is plagued with an infestation of east coast weeds.  Phil Pannill, our trusted Land 
Manager, would like to conduct an inventory of the worst weed patches on the NCTC 
property.  Phil would like to document patch size and estimate percent cover of the 
weed species.  Permanent photo-point stakes should also be established at a sample of 
the most horrible sites and pictures taken to document the horror. 


Project Objectives: 


1. Map the invasive weeds on NCTC property over a 6 month period (May-Oct.). 
2. Establish permanent photo-point markers at the worst infested sites and take 


initial photographs. 


Existing Data: (CSP7200\Exercise3 and Imagery) 


1. Imagery\Aerial_2009.sid 
2. Tables\Weeds.xlsx 


Methodology: 


1. Create a file geodatabase with weed (polygon) and photo-point (points) feature 
classes. 


2. Create domains (i.e., drop-down pick lists) to speed-up data collection. 
3. Collect the data with ArcPad 10 on a 2008 series Trimble GeoXH GPS receiver. 
4. Create metadata using the project summary as a reference. 


Deliverables: 


1. A file geodatabase with feature classes, domains and metadata. 
2. Photographs of the most despicable infested sites. 
3. A map document (.mxd) and a detailed map printed on a large format printer.  
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TASK 1–Create the Geodatabase Structure 


1. Remove the Feature Class Design Form in the back of this exercise.  This 
completed form will serve as your structural design template while working 
through the exercise. 
 


2. Create a new file geodatabase in the Exercise2 folder and name it 
Weed_Project.gdb. 
 


3. Create a new feature dataset and name it Inventory. 
 


• Assign the NAD83, UTM Zone 18 datum and coordinate system to the 
feature dataset.  Use “none” for the vertical datum. 


 
4. Right-click on the Inventory feature dataset and create a new feature class.  


Name the feature class Weeds_Area.  Make sure the data type is a Polygon 
Feature.  Click Next twice, keeping the default configuration setting. 
 


 
 
 


5. Following the Feature Class Design Form, create the first new field “GPS_Date”.  
Change the data Type to Date.  Keep the “Yes” in all the Allow NULL values 
field.  See the example below. 
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• Continue creating new fields as listed in the data form.  Change the text 
field size in the field properties section as listed on the data form, but 
ignore the Domain Name and Default Value columns for now.  We’ll add 
those in the next section.   
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6. Next, create the Photo_Points feature class as shown on the data form.  


However, when you get to the blank fields screen, select the  button 
towards the bottom of the screen. 
 


• Browse to the Weeds_Area feature class you just created.  Click Add. 
 


 
 


• Delete the last five fields by selecting each field and hitting Delete on your 
Keyboard.  Add the Marked, Pic_ID and Picture fields as listed on the 
data form. 


 
• Have the Picture raster field be managed by the GDB (i.e., the 


geodatabase).  Click Finish when done. 
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TASK 2–Create the Domains 


According to our data form we need to add 4 domains to our geodatabase.  Let’s create 
the shortest domain by hand first, and then use ArcToolbox to add the rest from Excel 
worksheets. 


1. Right-click on the Weed_Project geodatabase (i.e., the can) and select 
Properties. 
 


• Click the Domains tab.  Type “Marked” in the first cell and provide a 
description.  Change the Field Type to Single Integer and the Domain 
Type to Coded Values by clicking on the far right end of the cell, which 
will pop-down a list of data types.  Fill-out the Coded Values section as 
shown below. 
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• Click Apply and OK when done.  For longer lists, its best to type the 
attributes in an Excel worksheet then upload the values into domains 
using the Table to Domain Tool in ArcToolbox.  


 
2. Minimize ArcCatalog for a moment.  Open the Weeds Excel file in the Tables 


folder using Windows Explorer or MS Excel.  Familiarize yourself with the 
attributes on each of the worksheets.   
 


3. Add your last name to the Technician list worksheet just below “Other”.  Save 
the document and close Excel.   
 


 
 


4. The next step will be to import the worksheets into the geodatabase as domains.  
 


• Maximize ArcCatalog and open ArcToolbox   on the side bar.  
 


• Locate the Table to Domain tool in the Data Management Tools > 
Domains Toolbox.  Double tap on the Table to Domain to activate the 
tool. 
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• Click browse  at the Input Table field and navigate to the Weeds Excel 
file in the Tables folder.  Double tap on the Weeds Excel file to view the 
worksheets.  Select Technician$ and click the Add button. 


 


 
 
 


• Using the dropdown list button on the end of each field, select the 
Technician for both the Code and Description fields (it’s the only column 
in the worksheet). 


 


• For input workspace, browse  to the location of the Weeds_Project 
geodatabase and click Add. 


 
• Accept the default Domain Name, which will be the “Technician” Excel 


column header.  Your screen should look like the one below.  Click OK 
when done. 
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5. Use the Table to Domain tool to import the GPS_Device and Weed_Species 
Excel worksheets.   
 


• When you’re importing the Weed_Species worksheet, use the 
Weed_Code column for the Code Field and the Weed_Species column 
for the Description field.  Make sure to name the domain Weed_Species. 


 
6. Right-click on the Weed_Project geodatabase, select Properties and the 


Domains tab to verify the values were successfully imported and the domain 
names match those on your design form. 
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TASK 3–Assign Domains to Fields  


1. Right-click on the Weeds_Area feature class and select Properties. 
 


2. Click on the Fields Tab. 
 


3. Select the GPS_Device field and specify the GPS_Device domain in the Field 
Properties section of the dialog. 
 


4. In the Default Value field type the default domain value listed on your design 
form.  Click the Apply button after you assign each domain.  Click OK when 
done. 
 


 
 


5. Finish assigning the domains to the remaining fields in both the Weed_Area and 
Photo_Points feature classes as listed on your design form.   
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TASK 4– Create Data in ArcMap 


1. Close ArcCatalog and Launch ArcMap . 
 


2. Open a New Blank Map and Add the Aerial_2009.sid layer from the 
GIS_Data\Imagery folder. 
 


3. Add  the Inventory feature dataset and both layers will be loaded.  If the 
imagery is the top layer in the Table of Contents, just drag it down to the bottom 
of the list so you can see the point and polygon features once you start editing. 
 


4. Start and editing session from the Editor Toolbar. 
 


 
 


5. Select the Photo_Point layer in the Create Features Dialog and tap anywhere 
on the map to create a point. 
 


 


  


Geodatabase Design                                                                          12 







GIS Data Development and Management  2014 
U.S. Fish and Wildlife Service                         National Conservation Training Center 
 


6. Click on the Attribute button in the Editor Toolbar to view and edit the Attribute 
table. 


 
 


7. What fields are automatically populated and why? 


_______________________ 


_______________________ 


_______________________ 


_______________________ 


 
8. Click on the value’s in each field.  Notice the drop-down menu’s in the fields that 


are auto-populated.  These are the domains that you created and assigned to 
each field.   The value’s that our auto-populated are the default values you gave 
to each domain.   
 


9. Why do you have a Yes in the Marked field when you gave it a “1” as a default 
_____________________________________________________________? 
 


10. Next we’re going to add a JPG raster image to the picture field to document our 
weed infestation status at the photo point.    
 


• Click on the <Null> value in the Picture field and select Load. 
 


• Browse  to a file in the Picture folder.  Select any JPG file and click the 
Add button.  Click OK. 


 
• You should see the photo in Picture field on the Attributes table.  Now, 


you can’t do that with a shapefile! 
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11. Create a couple more points and load a photo into the picture field for each one. 


 


12. Create a new polygon in the Weeds_Area layer.  Examine the attributes  to 
make sure all the assigned domains are working properly. 
 


13. Stop editing, save edits and save the map document.  Name it Weeds.mxd.  
We’ll be using this mxd and data in the next exercise. 
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Feature Class Design Form 


Feature Class or Table Name Data 
Type Field Name Field Type Text 


Length Domain Name Default Value 


Weeds_Area Polygon GPS_Date Date       


    GPS_Device Text 20 GPS_Device GeoXH 


    Technician Text 35 Technician "your last name" 


    Weed_Species Text 35 Weed_Species   


    Percent_Cover Floating       


    Comments Text 40     


              


Photo_Points Point GPS_Date Date       


    GPS_Device Text   GPS_Device GeoXH 


    Technician Text   Technician "your last name" 


    Marked Short Int    Marked 1 


    Pic_ID Text 25     


    Picture Raster       
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Exercise 5 – Creating, Exporting and Importing Metadata  


 
 
Session Objectives:  At the conclusion of this session, you will be able to: 
 
 
 Create and add attachments to records in a table. 


 
 Create new metadata for geodatabase feature class using ArcCatalog. 


 
 Export and Import metadata from a geodatabase feature class using 


ArcCatalog 10. 
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Material Created By:  Eric Kelchlin (October 2011) 


Revision: November 2013 


Software:  ArcGIS 10 SP5 


Directory Path: C:\ or D:\CSP7200\Exercise4 and Exercise5 


Data: Weed_Project_Summary.docx, Metadata.docx in Exercise5 


GDB: Weed_Project.gdb in Exercise4 


MXD: Weeds.mxd from Exercise4 
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TASK 1 – Creating Attachments to Annotate Records in a Feature Class 
 
Yesterday you created a geodatabase for an invasive weed species monitoring project 
on the NCTC campus.  You also learned how to add a picture to a record (i.e., a single 
row or feature in a table) in the Photo_Points feature class.  Today, you’ll learn how to 
create an attachment to add multiple pictures to a single record.  You’ll also learn how 
to attach documents for annotation.  This is smart way to create user defined metadata. 
 
All data are located in the CSP7200\Exercise4 folder, unless otherwise stated. 
 
1. Open the Weeds.mxd.  


 
2. To add an attachment, we first need to create a location to store the attachments.  


The location is an auto-generate table that is linked to the feature class via a 
logical link known as a relationship class.   


 
• Open ArcCatalog from the side bar.  Right-click on the Photo_Points 


feature class and select Attachments > Create Attachments.  Notice the 
new table and relationship class. 
 


 
 
 


• Open the new table.  What field will the attachments be stored in and what 
data type is it_____________________________________? 


 
3. To add attachments, simply start and editing session and open the Photo_Points 


attributes table. 
 


• Right-click on one of the records (the far left grey cell) and select Open 
Attachment Manager. 


 
• Click the Add button and browse to the Pictures folder in Exercise2.  


Select all the pictures and the Wine_Berry_Description.pdf.  Click Add 
again and OK to load all the items. 
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4. To view the attachments, click on the attachment icon on the editing template and 


click on any of the attachments. 
 


 
 


5. Stop editing, save edits and close ArcMap. 
 


6. Attachments can be very useful to annotate records in a table.  Next we’ll show 
you how to create “official” metadata for the feature class. 
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TASK 2 – Creating Metadata in ArcCatalog 10 
 
In this section, you will utilize the metadata editor in ArcCatalog 10 to generate “quick 
and dirty” metadata for your data layer.  Not all the mandatory fields are populated, only 
the bare minimum.  It’s possible and recommended to paste text from reports into text 
fields.  A GIS project summary report would be perfect fodder for metadata! 
 


1. Launch ArcCatalog  from the desktop.  
 


2. From the Customize menu, select ArcCatalog Options.   
 


3. Click the Metadata tab and change the metadata style is FGDC CSDGM 
Metadata.   Also make sure that the metadata updates box is checked as shown 
below.  Click OK. 


 


 
 


4. In the catalog tree on the left hand side of the screen, navigate to the 
Weed_Project.gdb.   


 
5. To start editing metadata, simply highlight the Photo_Points feature class, select 


the Description tab and select the Edit tool  in the Items Description 
window.   See the example on the next page.  
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7. Open the Metadata Word document in the Exercise3 folder.  Copy the blue text 


items and paste in the appropriate sections. 
 
Click Item Descriptions in the Overview section and add the following items: 


 
Tags – add subject keywords separated by commas. 
 
USFWS, NCTC, Weeds, Inventory, Trimble GeoXH 
 
 
Summary – add a brief summary of the data. 
 
GPS field data collected as part of the GIS Project Design I class 
(CSP7200) in December 2013.  Data were collected via a Trimble GeoXH 
2008 series GPS receiver running ArcPad 10, Service Pack 2.  Averaging 
was enabled (10 seconds for points, 5 seconds for vertices).  A 2 second 
logging rate was used for streaming line and polygon features.  WAAS 
was enabled to improve accuracy.  No PDOP limit was applied. Mission 
planning was not conducted.  Data were Post-processed using Pathfinder 
Office 5.10. 
 
 
Description – add an abstract explaining its data and purpose.   Open and copy 
the text from the Inventory_Project_Summary Word document in the 
Exercise3 folder and paste in this field. 
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Note:  you can also add a hyperlink to any web document.  To do this, type a 


word like “Description”, then highlight the text and click the hyperlink tool .  
Next copy and paste this web address in the field and click Apply. 
 


 
Credits – add the person(s) name or organization name. 
 
USFWS National Conservation Training Center 


 
Use Limitations – add the following statement: 
 
Although these data and information have been processed successfully 
on a computer system at the USFWS, no warranty expressed or implied is 
made regarding the accuracy or utility of the data and information on any 
other system or for general or scientific purposes, nor shall the act of 
distribution constitute any such warranty. This disclaimer applies both to 
individual use of the data, and information, and aggregate use with other 
data and information. It is also strongly recommended that careful 
attention be paid to the contents of the metadata file associated with 
these data and information. The USFWS shall not be held liable for 
improper or incorrect use of the data and information described and/or 
contained herein.  
 
 


8. Select Topics & Keywords and fill-out the following sections: 
 
Topics - check the Biota and Environment boxes 
 
Theme Keywords – add keywords separated by commas 
 
Weeds, Inventory, Photo Points 
 
Place Keywords - add keywords separated by commas 
 
National Conservation Training Center, WV 


 
 


9. Click on Citation Contacts and type your contact and contact information.  
 
 


10. Click on Details in the Resource section and change the New Status to 
Completed. 


 


11. Click the Save button  when finished.   
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12. To add a thumbnail image to your metadata, simply click on the Preview Tab and 
select the Add Thumbnail icon on the Geography Toolbar.  Click back on the 
Details Tab to view the thumbnail. 
 


 


 
 
 
 


Congratulations!  You just created metadata for your GIS data. The next sections 
show how you can export this information and use it as a metadata template for 
other datasets to save time. 
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TASK 3 – Exporting Metadata in ArcCatalog 10 
 
 


1. Highlight the Photo_Points layer and select Export from the Description Tab. 
 


 
2. In the Translator field, browse to the ArcGIS2FGDC.xml translator file located in 


the C:\Program Files (x86)\ArcGIS\Desktop10.0\Metadata\Translator\ folder. 
 


• Save your file as Metadata_Template.xml in the Exercise5 folder.  See 
the example below.  You will need to type the .xml extension in the file 
name! 


 


 
 
 


3. Click OK and Close.  You should see the Metadata_Template file in your table 
of contents.  If not, then click View > Refresh on your main toolbar. 
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TASK 4 – Importing Metadata in ArcCatalog 10 


 
1. Highlight your source layer, use Weeds_Area for this example, and select 


Import from the Description Tab. 
 


 
 


2. Change the Import Type to FROM-FGDC and click OK and Close.  You will have 
some green errors because not all the mandatory FGDC fields are filled-out. 
 


 
 


 
3. View your new metadata.  Did everything come over correctly?  


 
 
For more information on USFWS metadata standards, useful metadata tools and 
templates, go here: 
  
http://www.fws.gov/stand/standards/pr_biomet_WWW.html 
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Exercise 6 – Sampling Design  


 
 
 
Session Objectives - At the conclusion of this session you will be able to: 
 
 
 Create systematic and random sampling designs to inventory wildlife populations 


and their habitats. 
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Materials created by: Eric Kelchlin (Jan 2013) 


Revision: November 2013 


Software: GME v 7.1 (optional), ArcGIS 10, SP5 


Directory Path:  CSP7200\Exercise6 


GDB: Exerc6.gdb 
MXD: Sample_Design.mxd 
Imagery: 28Apr12_402.img (UTM 43N, WGS84) 
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SECTION 1 – Creating Sampling Points, Plots and Transects 
 
You will be asked to generate sampling points, plots or transects across a study area at 
some time in your career.  With the help of ArcGIS and GME (Geospatial Modeling 
Environment) you can easily create a sampling design for a wide array of inventory and 
monitoring applications.  Best yet, you can then upload this data into your GPS unit and 
laydown the sampling design in the field. 
 
All data are located in the Exercise6 folder unless otherwise stated. 


 
TASK 1 - Create a Stratified Random Sample of Points 


 
1. Launch ArcMap and open the Sampling_Design.mxd map document. 


 
2. Create a stratified random sample 


of points within the study area.  
Save all your data in the Maldives 
feature dataset of the Exerc6 
geodatabase. 
 
• From ArcToolbox on the side 


bar open the Create Random 
Points tool (Data Management 
Tools  Feature Class).  Fill 
in the fields as shown here and 
click OK.   
 


• NOTE: you will get an error 
message if the inter-point 
spacing (i.e., minimum allowed 
distance) is too large for the 
number of random points you 
want. 
 


 
3. Notice how the data were 


automatically stratified within each 
unit/polygon.  If you wanted only 
50 sampling points throughout the 
entire island, how would you do 
this? 
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4. Repeat the process and create a second layer (i.e., Random2), but this time 
change the number of random points and spacing to something different AND do 
not allow the points to occur on the Island polygons.  Use the Select by Attribute 
query to help you out on this. 
 
 


TASK 2 - Create a Systematic Sample of Points  
 


The Fishnet Tool in ArcToolbox is a great way to create a systematic arrangement of 
points across an entire study site or small areas of interest.  This tool automatically 
creates a grid (i.e., fishnet) of polylines or polygons.  We’re only concerned with making 
points, so make sure to check the box “create label points” at the bottom of the tools 
dialog or else no points will be generated 


 
1. Remove the random point layers from the TOC.  


 
2. Create a 100 x 100 meter point grid across the entire study site using the Fishnet 


Tool. 
 
• Launch the Create Fishnet 


Tool (Data Management 
Tools  Feature Class) in 
ArcToolbox.  Fill in the fields 
as shown here.  Name the 
feature class Grid1. 
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3. Next, use a Select by Location query to select only those points (from the 
Grid1_label layer) that intersect the Study_Area. 
 


4. Export the selected points and save as a new feature class.   
 


• Right-click on Grid1_label and select Data > Export Data. 
 


• Name it Grid_100m. 
 


5. Remove the other grid layers from the TOC. 
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TASK 3 - Create Sampling Plots  


 
Once you created your random points or point grid, it’s common that the sampling 
strategy requires an area to be sampled at those point locations.  Estimating percent 
cover of plant species, for example, is commonly done within a square frame known as 
a quadrat.  These quadrats are small, ½ to 1 meter square, and although we can easily 
create them, it would be rather pointless to upload such small quadrats into GPS units 
for field use.  Just bring the real quadrat out to the field and navigate to the sampling 
points. 
 
However, when you want to create a large plot with a specific dimension and sample 
within the plot, then GIS and GPS can help.  Why take the tape measure in the field 
when you have the plots and sample points uploaded into the GPS unit?   


 
1. We’re going to create a 200 x 200 meter square plot using common editing 


techniques in ArcMap.   
 


• Create a new polygon feature class in the Maldives feature dataset.   
 


• Name the new layer Sampling_Frame. 
 


• Change the symbology fill to no color and increase the line size and line 
color to improve visibility. 


 


2. Start an editing session and zoom into  a section of the lower island. 
 


• Select Sampling_Frame in the Create Features dialog to initiate editing, 
and then select the Rectangle Construction Tool. 
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• Hover over the map with your mouse.  You should now see that your 
arrow has turned into a “+” symbol with a small box in the bottom right 
corner.  
 


• Right-mouse click and select Length.  Type in 200 and hit the enter key. 
  


• Right-mouse click one more time, and select Width.  Type in 200 and hit 
the enter key.  You should now have a 200 meter square plot. 
 


3. Make two more 200 meter square plots.  The quickest way to do this is to use the 


Editor Tool arrow  on the Editor Toolbar.   
 


• Using the Editor Tool arrow, right-click on the plot and select Copy, then 
right-click and select Paste twice!  This makes two copies of the plot 
directly on top of each other.  Click OK to have the Sampling_Frame layer 
be the Target each time. 


 
• Move each plot by holding down the left-mouse button and dragging the 


plot to another location.  You’ll need to do this twice. 
 


• Stop Editing and save your edits.  
 


 
 
 


4. Now you could easily create random or systematic points within each plot.  Give 
it a shot of you have extra time. 
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TASK 4 - Create Sampling Transects  
 
In this last section were going to create 100 meter long transects and generate 
systematic points along these transects.  This sampling design is often used for bird 
point count transects and point-line-intercept vegetation surveys. 


  
1. Create a new line feature class and name it Transect100.   


 
2. Change the symbology of the line to better see the line as it’s digitized on the 


on the imagery.  I chose the Highway Ramp symbol.   
 


3. Start an editing session and create the 100 meter long transect.   
 


 
 


• Left-mouse click once on the image.  Drag the mouse down and right-
mouse click.  Select Length in the pop-up menu.  Type 100 and hit Enter 
on the keyboard. 


 
• Drag the mouse in the direction you want the transect follow and left-


mouse click to create the second point.    
 


• Right-click and select the Finish Sketch  button on the Feature 
Construction Toolbar, and you’re done. 
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4. Make two more 100 meter transects that run parallel to the first using the Editor 
Toolbar.  
 
• Click on the Editor button on the Editor Toolbar and select Copy Parallel. 


 
• Use a 20 meter distance shown below and click OK.  You should now 


have 3 transects, each one paralleling the other at a 20 meter distance. 
 


 
 
 


• Stop editing and save edits. 
 
 


5. Finally, we’re going to add sampling points at regular intervals along each 
transect. 
 
• First, create new point feature class and name it Transect_Points.  


Create a short integer field in the attribute table and title it Point_ID.  We’ll 
use this field for labeling the points later on. 
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• Start a new editing session. 
 


• Use the Editor Tool arrow  to select one of the transects.   
 


• Click on the Editor button and select Construct Points.  
 


 
 


• Create a point every 10 meters, starting from the beginning of the 
transect.  See the example below.  Make sure you’re using the right 
Template. 
 


 
 


• Repeat this process for the other two transects. 
 


6. Label the Transect_Points layer using data from Point_ID field.  But, first create 
the data! 


 
• Open the Transect_Points Attribute table and use the Field Calculator to 


create a sequential list of numbers in the Point_ID field.     
 


• Right-click on the Transect_Points layer and select Label Features.   
 


• Change the field to Point_ID in the layer Properties if needed. 
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7. Stop editing, save edits, save  the map document (MXD) and close ArcMap. 
 
 
 
Challenge Exercise:  Create another transect and add points to the line at RANDOM 
distances.  What tool(s) did you use________________________________________? 
 
 
Want More? 
 
For more advanced sampling design tools check-out the free Geospatial Modeling 
Environment (GME) software.  It does not work with geodatabases (only shapefiles), but 
it integrates R in the background and has some pretty awesome sampling tools. 
 
You can find the software in the Utilities folder if not already installed. 
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Exercise 7 – Creating a Relational Database from a Messy 


Dataset 
 


 


Session Objectives:  At the conclusion of this session, you will be able to: 


 
 Clean-up a long-term monitoring and inventory dataset using ArcGIS and MS 


Access. 
 


 Restructure a flat table into a relational database. 
 
 Use MS Access to view, query and analyze data in related tables. 
 
 Connect to an MS Access database and import tables into a geodatabase. 
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Material Created By:  Eric Kelchlin (November 2013) 


Revision:  March 2014 


Software:   ArcGIS 10, SP5 


Data Path:  C:\ or D:\CSP7200\Exercise 7 


Databases:  Bombayhook.gdb 


Tables:  Plants.dbf 


MXD:   Exercise7.mxd 


 


 


Workflow 


 


 


  


Examine the Dataset for Design and Data Errors 


Restructure Table and Fix Data Errors 


Summarize Data  


Create a Relational Database 


Query Data  Across Tables and Display Results 
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Data Management 


In this Exercise, you will utilize ArcGIS to clean-up a 15 year long wetland monitoring 
dataset from Bombay Hook National Wildlife Refuge.  The dataset contains location 
information on sample sites (n=220), saltmarsh vegetation species and percent cover 
values that are expressed as Daubenmire cover class mid-points. 


Cleaning-up messy data involves a systematic process of finding errors and fixing them.  
The objectives are project specific but they typically involve searching for and fixing 
typing errors, deleting records that are redundant or useless for data analysis, merging 
similar records (this is no time to be a splitter!), recoding values and restructuring the 
table for data analysis. 


Long-term monitoring and inventory datasets are plagued by errors because the 
sampling protocol and sampling intensity changes annually due to employee turnover 
and short-sighted funding.   Observer bias can also be a major problem with long-term 
data sets.  Some field technicians are more skilled at plant and animal identification 
than others, which results in a dataset rich with species diversity in some years and just 
deplorable in other years.   


The goal of this project is to monitor salt marsh plant species composition and percent 
cover changes though time.  Our goal is to clean-up the dataset, restructure the flat 
table into a relational database with multiple related tables and examine plant species 
trends. 


Study Site 
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TASK 1 – Examine the Dataset for Design and Data Errors 


All data are located in the CSP7200\Exercise7 folder. 


The first step is to explore the dataset(s) to find errors, redundancies, missing values 
and determine if the table structure can be reduced and broken-up into multiple tables. 


1. Open the Exercise7.mxd. 
 


2. Open the Attribute Table and examine the dataset for errors.   
 


• Do you see any potential issues with the dataset?  
  


• Should we simplify the field names? 
 


• Should we restructure the dataset into multiple related tables? 
 


3. What fields represent the following variables: 
 
• Sample Sites____________________________________ 


 
• When Sampled___________________________________ 


 
• Plant Names_____________________________________ 


 
• Sampling Unit (i.e., percent cover estimate)____________________ 


 


TASK 2 – Table Restructure  


The biologists visited each sample site an annual bases between 1991 and 2007.  A 
GPS position was retaken each time to create a record for data entry.  The result is a 
stack of points on top of each other.  I would like to reduce this stack down to the total 
number of unique sample sites.  This dataset will become the primary table that all the 
other secondary tables are linked to via a series of relationship classes.  This table will 
also be the only one that contains the geometry of the point feature; all other tables will 
contain attributes that are linked to the primary table using the unique sample site 
name. 


A first step would be to restructure the dataset into multiple tables starting with the 
sample sites field (Im_Biol_Monit_Sites_Pt_Pt_Name). To do this, let’s first dissolve  


1. Dissolve the table by sample sites field. 
 
• Click on the Geoprocessing toolset from the main toolbar and select 


Dissolve.   
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• Name the new feature class Sampling_Sites and save it in the 
Vegetation feature dataset within the Bombayhood.gdb. 


 
• Use the Im_Biol_Monit_Sites_Pt_Pt_Name at the dissolve field as 


shown below.   
 


• Make sure the Create Multipart Features box in the bottom of the dialog 
is unchecked.  Click OK.  The new feature class will be added to the 
Table of Contents. 
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2. Open the Im_ImpoundVeg_1991to2007 Attribute Table.  How many records 
are in this table ____________?   
 


3. How many records are in Sampling_Sites ____________?   
 


So, now you can see that for every plant recorded in the field, a separate point 
was created to add the plant data. This is a very poor database design.  The 
annual monitoring database should be designed as a relational database to 
avoid taking GPS points each year.  You only need to fill-out related tables 
that are linked to the GPS points. 
 


4. Open the Sampling_Sites attribute table to simplify the field names by 
creating a new field and copying over the data into the new field.  You could 
rename the field directly, but it will only be an alias. 
 
a. Add a new field from the Table Options button  .   


 
• Name this new text field Site_ID.  Use a length of 10. 


 


 
 


• Next, right-click on the Site_ID field and select Field Calculator.  Copy 
the values from the neighboring field by simply double-clicking on the 
Im_Biol_Monit_Sites_Pt_Pt_Name field.  Click OK. 
 


• Right-click and delete the old field.  Close the table. 
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TASK 3 – Load Data into a New Table and Export to MS Access 


Many of the fields that are not necessary for our purposes and the field names are 
cumbersome.  This section shows you how to load (i.e., extract) only the data we need 
and place it into a new table.  This method does not affect the original dataset and is 
therefore much safer to making erroneous errors than can’t be undone.  Let’s load only 
the data we want into a table and fix many issues in one step.  


 
1. Open ArcCatalog from the docked sidebar.   


 
• Right-click on the Bombayhook geodatabase and view the Data1 table 


structure.  The table structure is shown below as well.  We’ve already 
created the table for you to save time. 


 


Field Name Data Type Text Length 


Sample_ID Text 10 


Impoundment Text 35 


Growyear Double  


Common_Name Text 35 


Midpoint Double  
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2. In ArcCatalog, right-click on the Data1 table and select Load Data. 
 


• Use the Im_ImpoundVeg_1991to2007 feature class as the input dataset. 
 


• Match the Source fields with the Target fields, click Next once. 
 


 
 


• Build a SQL query   to remove the midpoint records with 
Null values.  See the examaple below.  Verify the query then click OK and 
Finish. 
 


 
 


3. Export the table as a .dbf file for import into MS Access.  Name the file 
Data2.dbf and save in the Exercise7 folder. 


  


Data Clean-up and Relational Database                                                                                    8 







GIS Data Development and Management     2014 
U.S. Fish and Wildlife Service                         National Conservation Training Center 
 
TASK 4 – Import Data into MS Access 


 
1. Launch MS Access and create a new database. 


 
• In the lower right corner of your screen, browse to our working folder and 


name the new database BHNWR.accdb (short for Bombayhook National 
Wildlife Refuge). 
 


• Click the Create button when done. 
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2. Create a new table from the Data2.dbf file you saved from Task 3. 
 


• Click the External Data tab > More button and dBASE File option. 
 


• Browse to the location of the Data2.dbf file and click OK and Close. 
 


• You should now see a table called Data2 in the section of Access called 
the Objects Navigational Pane. 
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TASK 5 – Summarize the Data  


Multiple samples/transects were taken at the same sample sites in some years.  This 
could be an artifact of different sampling protocols, but we really don’t know why.  The 
best we can do is calculate a mean midpoint value for each sample site, relative to year 
and plant species.  


1. Sort the records in the Data2 table across multiple fields at once.  
 


• Double-click on the Data2 table to view the table in the data view. 
 


• Move the Growyear field before the Impoundmen field by left-clicking on 
the header, holding down the mouse button and dragging the field over.  
This does not change the design of the data table; only how we view and 
sort the data. 


 
• Next, select all the fields except the midpoint field by selecting the Site_ID 


header and dragging your mouse over to select all the other fields. 
 


• Right-click on the highlighted area and select Sort A to Z.  You can also 
find the sort on the Home tab section of the main menu. 


 


 
 


2. Browse down the table and notice how the dataset contains multiple subsamples 
(i.e. transects) for some of the sample sites within each year.  The dataset has 
should be summarized by sample site, year and plant species before we proceed 
to any analyses.  
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3. To do this, we’ll need to create a query. 


 
• Click on the Create tab on the main menu and select Query Design. 


 


 
 
 


• Click the Add button to bring in the only table we have. 
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4. To calculate the average midpoint follow these steps: 
 
• Step 1- Double-click on each field in the Data2 table to add it to the query.  


Add the Sample_ID, Growyear, Common_Nam, Midpoint and 
Impoundmen fields. 


• Step 2 - Click on the Totals button  . 
 


• Step 3 - Change the Group By in the Midpoint Totals row to Avg and to 
Count for the Impounden field. 


 
• Step 4 - Click the Run button. 


 


 
 


 
5. How many records do you have now___________? 


 
6. Since this is our clean, summarized dataset that is ready for analysis, let’s go 


ahead and make a new table out of this query. 
 


7. Click the Design View button   and the Make Table query button  . 
 


8. Name the table Data_Sum and click OK. 
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9. Run    the query and select Yes to accept your changes.  
 


10. Right-click on the Query1 tab and select Close.  Click No to save changes.  We 
have our results in the Data_Sum table, so there is no need to save the query. 
 


11. Right-click (or double-click) on the Data_Sum table to open it.  Click on the 
Home tab > Design View button and lets clean the field names up a bit and add 
some descriptions. 
 


12. Change the field names and add the following descriptions as shown below: 
 


 
 


13. Click on the Home tab > Datasheet View button  and save your changes.  
Note: you can also switch between design and datasheet view from the tiny little 
icons on the right bottom of the screen. 
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TASK 6 – Create a Relational Database 


Creating relational databases is all about linking objects (i.e., tables and queries) 
together using a common field for the purpose of viewing or extracting data across 
multiple datasets.  This design strategy creates a stair-stepped hierarchical data 
structure, which is in stark contrast to the “flat” mega-tables that scroll-on forever.   
 


1. First, let’s import another dbf file. 
 


• On the main menu select External Data > More > dBASE File.   
 


• Browse to the location of the Plants.dbf file and import it into our 
database.   


 
• Name the table Plants. 


 
2. Next, we’re going to create a relationship to link the Data_Sum table (the 


parent/primary table) to the Plants table (the child/secondary table).   
 


• On the main menu select Database Tools > Relationships button. 
 


• Add the Data_Sum and Plants tables to the screen.  Either right-click to 
add the tables or simply drag them over from the Objects Navigation 
Pane. 


 
• To create the relationship, select the Common_Name field in the 


Data_Sum table and drag it over to the Common_Nam field in the Plants 
table.  Click Create. 
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TASK 7 – Query Data from Related Tables and Export Results 


Let’s say for example that you want to calculate an average percent cover estimate for 
Graminioids (i.e., grasses) with OBL national wetland status (i.e., obligatory wetland 
plants) in grow year 2000 for each sample site.  Here are the process steps: 


 


1. Create a new query and add the two tables we just related to each other. 
 
• Add the fields as shown below. 


 


 
 


• Click on the Totals button    to add the Group By totals field. 
 


• Change the Totals Group By items to the following by clicking the Group 
By and selecting a different action from the dropdown menu. 
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• Next, narrow the results by our search criteria.  Add the following text in 
the Criteria field as show below. 


 


 
 


• Why do you think we created the Like “*OBL*” query SQL language in 
the Nat_Wetlan field and did not just use OBL?  Open the Plants table 
and examine the data to see why. 


 
• Run the query. 


 
• Save the query by right-clicking on the Query2 tab.  Select Save and 


name it OBL_Grasses_2000. 
 


 
 


2. Let’s export this table for use in ArcMap. 
 


• From the main menu, select the External Data > More > dBASE File. 
 


• Save the .dbf file in the working folder and exit Access.   
 


Note: Instead of exporting the results of the query into a .dbf file, you could have linked 
the query into the Bombayhook.gdb using an OLE DB connection in ArcCatalog.  That 
way any changes you make in Access will show-up in your geodatabase. 
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TASK 8 – Graphically Display Results in ArcMap 


 
1. Re-open the Exercise7.mxd.   


 
2. Bring in the OBL_GRASS.dbf into the Bombayhook.gdb.  Notice that the file 


name was shortened from the original OBL_Grasses_2000 file name.  Dbf file 
name can be no longer than 8 characters, so it was automatically shortened 
from the MS Access Export. 


 
• From ArcCatalog on the sidebar, right-click on the OBL_GRASS.dbf file 


and select Export.  Follow the Table to Table dialog. 
 


 
 


 
3. Join the data from the Sampling_Sites feature class to the PC_Grass table. 


 
• Add the Sampling_Sites feature class to the Table of Contents.  Remove 


any other feature classes. 
 
• Right-click on Sampling_Sites and select Join. 


 
• Fill-in the fields as shown below. 
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• Click on the Validate Join button   to make sure the join 
will work properly.  Often a join will fail because field headers contain 
invalid characters such as a period “.” or a reserved word such as 
“Percent”.  So it’s a good habit always validate you joins.   
 


• Click OK to complete the join.  
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4. Finally, let’s symbolize each sample point based on the average percent cover 
value to quickly to visualize trends in wetland obligate grass species from grow 
year 2000.  


 


• List your data by drawing order  in your Table of Contents. 
 


• Right-click on the Sampling_Sites feature class and select Properties > 
Symbology tab.   


 
• Change the symbol type to Proportional Symbols and use the 


AVGOFPERCE value.  Click OK. 
 


 
 


 
 


• Add  a Bing base map to help with your interpretation.  
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Exercise 8 – Creating a Land Cover Layer with Topology 


Rules 
  
 
 
Session Objectives:  At the conclusion of this session, you will be able to: 
 


 
 


 
 Delineate & attribute a simple land cover map 


 
 Create a Topology feature class and add rules 


 
 Validate the topology 


 
 Fix topological errors in a feature class 
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Software:  ArcGIS 10, SP5 


Directory Path: CSP7200\Exercise8 
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SECTION 1 – Heads-up Digitizing in ArcMap 10 
 
Digitizing landscape features from aerial photos or satellite imagery represents the most 
basic technique of mapping vegetation.  Sometimes this level of detail is all you need, or 
in most cases, all you can afford giving time and budget constraints.  This technique 
works best for general land cover features such as forest, grassland, agriculture and 
developed land.  Small plant communities or species of interest that are poorly defined 
in the imagery can be captured with a GPS unit on the ground and added to the map 
later on. 
 
All data are located in CSP7200\Exercise8, unless otherwise stated. 
 
TASK 1 – Add a Domain and New Field 
 


1. Launch ArcMap and open the Exec8.mxd.  
 


2. To make attributing polygons easier, let’s add a Cover_Type field and a 
domain to generate a simple drop-down list. 


 
• First, create a new domain.  Open ArcCatalog on the sidebar and right-click 


on the Exercise8.gdb.  Select Properties and the Domains tab. 
 


• Name the new domain Cover_Types and add a description. 
 


• Change the Field Type to Text and add the following cover types in both 
the Code and Description fields:  Forest, Field, Developed and Water. 


 
• Open the Land_Cover attribute table and create the new Cover_Type text 


field.  Give the field a text length of 20 and assign the domain we just 
created to the domain field. 
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TASK 2 – Set Editing Preferences and begin Editing 


 
1. From the Editor Toolbar, select Snapping > Snapping Toolbar.  Dock the new 


toolbar. 
 


2. From the Snapping Toolbar select Options 
and ensure the Snapping Tolerance is set to 
10 units.  Also, make sure to enable Use 
Snapping by selecting it. 


 
 


3. From the Editor Toolbar, select Options and 
ensure that the Sticky move tolerance is set to 
15-20 pixels to avoid accidental polygon 
moves.   
 
• Also, uncheck the Show mini toolbar box to hide a really annoying tool. 


 


 
4. Click on the Attributes tab and have the attribute dialog pop-up after each 


polygon is created. 
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5. Start an editing session from the Editor Toolbar.  The objective is to create 
polygons that are perfectly aligned so there are no gaps, dangles or overlaps.  
To do this you start from a single polygon, like we have here, and digitize new 
smaller polygons using the Cut Polygon Tool. 
 
• First select the single large polygon using the Edit Tool .   


 
• Zoom into the area you want to work-on using the mouse scroll wheel. 


 
• Select the Cut Polygon Tool   from the Editor Toolbar.  In order to 


make a cut you use one of two strategies: 
 


i. Start cutting the smaller polygon outside the boundary of the larger 
selected polygon and then double-clicking outside again to 
complete. 
 


ii. Overlap the polygon on itself to finish the cut.  This works great for 
smaller land cover features that are “islands” within the large 
selected polygon. 


 
6. Assign the polygon a cover type by first selecting the polygon with the Edit Tool 


 , then click the Attribute Tool  and select the cover type from our domain 
that we created earlier. 


 


 
 


7. Repeat these processes for a few more polygons to get the idea.  If you make a 


mistake remember that the Undue Tool  is a lifesaver! 
 


8. Stop Editing and Save Edits. 
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SECTION 3 – Heads-up Digitizing with Topology 
 
TASK 1 - Establish Topology Rules  
 
The land cover layer you just built was created without topology rules and as a result, 
the layer has no topological integrity.  In layman’s terms; the polygons may or may not 
border each other correctly.   
 
In this part of the exercise, we will use the LC_Premade feature class, one that has 
common errors that sometimes occur when editing.  Some polygons overlap their 
neighbors, while others don’t come close enough and leave gaps.  We’re going to apply 
the following topological rules (i.e., relationships) in the geodatabase to clean-up the 
mess: 
 
Rule 1 A polygon cannot exist in the space as another polygon or overlap;  
 
Rule 2 All polygon boundaries are contiguous and there are no gaps between 


polygons; and  
 
Rule 3 LC_Premade feature class must cover the Boundary feature class. 
 
 


1. Close ArcMap and open ArcCatalog.   
 


2. To make a new topology, simple browse to the Exercise8.gdb.  Right-click on 
the NCTC feature dataset, select New and choose  Topology. 


 
3. A New Topology dialog appears.  Read the overview information.  Click Next. 


 
4. Name the new topology Landcover_Topology.  Accept the default tolerances.  


Click Next. 
 


5. Select Boundary and LC_Premade to participate in the topology.  Click Next. 
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6. Enter the number of ranks to be 2.  Then, change the rank values as shown 
below.  Click Next.  


 


 
 


What does this ranking mean?  Feature classes of a lower rank will be 
snapped to feature classes of a higher rank.  So, in this example, the landcover 
layer will be adjusted to the boundary layer.  The boundary is ranked the 
highest because we want to minimize any adjustment of this feature.   


 
7. Select Boundary and LC_Premade to participate in the topology.  Click  Next. 


 


8. Use the  button to add the following 3 rules: 
 


 
 


9. Click OK when finished adding the topology rules.  A summary appears in the 
New Topology dialog.  Click Finish.               


 
10. Choose NO when asked to validate the topology.   We will validate the topology 


and fix any errors using ArcMap in the next section. 
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Why did we select these topology rules? 


 
Must Not Overlap – Requires that the interior of polygons in the feature class not 
overlap. The polygons can share edges or vertices. This rule is used when an area 
cannot belong to two or more polygons. It is useful for modeling administrative 
boundaries, such as ZIP Codes or voting districts, and mutually exclusive area 
classifications, such as land cover or landform type. 
 
Must not have gaps – This rule requires that there are no voids within a single polygon 
or between adjacent polygons. All polygons must form a continuous surface. An error 
will always exist on the perimeter of the surface. You can either ignore this error or mark 
it as an exception. Use this rule on data that must completely cover an area. For 
example, soil polygons cannot include gaps or form voids—they must cover an entire 
area. 
 
Must Cover Each Other – Requires that the polygons of one feature class must share 
all of their area with the polygons of another feature class. Polygons may share edges 
or vertices. Any area defined in either feature class that is not shared with the other is 
an error. This rule is used when two systems of classification are used for the same 
geographic area, and any given point defined in one system must also be defined in the 
other. One such case occurs with nested hierarchical datasets, such as census blocks 
and block groups or small watersheds and large drainage basins. The rule can also be 
applied to nonhierarchically related polygon feature classes, such as soil type and slope 
class. 
 
For complete listing of rules and fixes, open the ArcGIS help and look up topology rules. 
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  TASK 2 – Validate Topology & Must Cover Each Other Errors 
 


1. Close ArcCatalog and return to ArcMap. 
 


2. Add the topology to the map.  Click Add Data and browse to the topology. 
 


• When prompted, click Yes to add all associated feature classes. 
 


3. Zoom to Full Extent  if the entire boundary is not visible.  It’s time to validate 
to see to see if and where errors exist within the feature classes.   


 
4. Right-click in the top menu section of ArcMap and check the box next to 


Topology to load the toolbar.   
 


5. Start an editing session. 
 


6. Click the Validate Entire Topology   button.   
 


 
 


 
7. Click Yes when asked if you are really sure you want to validate the full extent. 


Yikes, look at all that red!    
 
8. Click the Error Inspector   tool.  This tool allows you to manage and interact 


with the topology errors on your map. You can search for violations of specific 
topology rules or for exceptions (errors that you mark as acceptable). You can 
also choose whether to inspect the currently visible extent or the entire 
topology. 


 


 
  


 
9. Click the Search Now button.  You should find 21 errors total. 
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10. Click on Down Arrow and Select Must Cover Each Other.  Click Search Now. 


 
11. Click on the first error in the Error Inspector.  Notice how the identified error 


turns black on the map.   
 


 
 
 


 
 


Digitizing and Topology 10 







Maldives GIS Training                                                                                   2013 
U.S. Fish and Wildlife Service                              National Conservation Training Center 
 


12. Close inspection reveals that the polygon lies outside the NCTC Boundary. 
 


To fix errors identified by the Must Be Covered By Feature Class Of rule we 
two options: 


 
Subtract: removes the overlapping portion of each feature that is causing the 
error so the boundary of each feature from both feature classes is the same.  


 
Create Feature:  creates a new polygon feature out of the portion of the 
overlap from the existing polygon so the boundary of each feature from both 
feature classes is the same.  


 
13. With this error selected, Right click on the selected line inside the dialog and 


select Subtract.  This will remove this area completely from the LC_Premade 
layer (reshaping the layer’s boundary).  Do not use Create Feature as this fix 
will modify the NCTC Boundary, which we know is correct and don’t want to 
change. 
 


 
 


• Now let’s Validate Entire Topology   again to make sure we fixed the 
problem.   
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14. Another way to correct topology is to use the Fix Topology Error Tool .  
Activate the tool on the toolbar by left clicking on it. 


 
• With the tool active, select the error in the northeast. 


 
 


15. Looking closely will reveal that there is a gap in the landcover between the 
NCTC Boundary and the existing landcover polygons.  To correct, we need to 
right click and select Create Feature to add in a polygon. 
 


• Once the feature is added, open the Attribute tool.  You will notice that it 
lacks any attribute data. You can code it individually or choose to merge 
it to an adjacent feature.   


 
• Select  both the new polygon and the Forest polygon to the south.  


Then in the Editor Menu, select Merge.  Be sure to select the feature 
with attributes to Merge to rather than the new one to retain those 
attributes! 


 


 
 


• Now let’s Validate Entire Topology   again to make sure we fixed the 
problem.   


 
• Notice this error is gone now.  Leave the remaining errors for now, we’ll fix 


them later. 
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TASK 3 – Must Not Have Gaps 
 
In this section we’ll examine the MUST NOT HAVE GAPS errors.  This is one of the few 
rules that will ALWAYS generate an error.  This is because you will always have an 
‘end’ to your polygons extents, and therefore a ‘gap’ where they do not touch another.  
We will start by marking this error as an exception 
 
 


Must Not Have Gaps 


This rule requires that there are no voids within a single polygon or 
between adjacent polygons. All polygons must form a continuous surface. 
An error will always exist on the perimeter of the surface. You can 
either ignore this error or mark it as an exception. Use this rule on data 
that must completely cover an area. For example, soil polygons cannot 
include gaps or form voids—they must cover an entire area. 


 


1. Click on the Fix Topology Error Tool  and click on the boundary so that it 
has a black outline.  


 


 
 
 


• Click the Error Inspector   button.  Notice there is only one error 
shown.  Since this one error will always show up when we inspect, let’s 
make it an exception so it won’t appear again.  That way, only the errors 
we are concerned with will be displayed. 
 


• Right click on the error in the Error Inspector dialog and choose Mark as 
Exception. 


 
• Validate the Entire Topology again to make sure we fixed the problem. 


 
• Close the Error Inspector dialog. 
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Tip: If you need to go back to the error you marked as an exception, in the Error 
Inspector check Exceptions and click Search Now.  Notice if you Right click on the 
Exception you can choose Mark as Error. 


 
 


2. Let’s look at actual errors now.  Zoom into the error as shown below. 
 


 
 


• Click the Error Inspector   button.  
 


• Click the Search Now button to quickly find this error.   
 


• Select the error in the Error inspector dialog.  The polygon should have a 
black outline. 


 
• To fix this error – Right click and select Create Feature, which will create 


a new polygon feature within LC_Premade (getting rid of the gap).  If you 
had multiple errors and use selected them all and used the Create Feature 
fix, the result will be one polygon feature per gap. So, be careful. 


 
3. Open the Attribute table and Attribute the new polygon to Developed. 


 


 
 


4. Validate the Entire Topology again to make sure we have fixed the problem. 
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TIP:  After any polygon editing session; including the subtracting and creating and 
merging we just did, remember your Acreages are no longer accurate!  ALWAYS 
recalculate your Acreages after editing shapes. 
 
TASK 4 – Must Not Have Overlap 
 
In this section, we will zoom-in to an area where polygons are overlapping.  Since a 
land cover can only have 1 attribute per location, these are errors that need to be 
corrected.  Overlapping polygons also lead to double counting of acreages. 
 


1. Zoom to full extents . 
 


2. Click the Error Inspector   button.   Click Search Now.    
 
3. Select the “Must Not Have Overlap” error to identify the error on the map.   


 
 


To fix errors identified by the Must Not Have Overlap rule we have 3 options 
within the error inspector: 


 
Subtract: removes the overlapping portion from each feature and leaves a gap 
or void in its place. This fix can be applied to one or more selected Must Be 
Covered By Feature Class Of errors. 
 
Merge: adds the portion of overlap from one feature and subtracts it from the 
others that are violating the rule. You need to pick the feature that receives the 
portion of overlap in the Merge dialog box that pops up. This fix can be applied 
to one Must Not Overlap error only. 


 
Create Feature: creates a new polygon feature out of the error shape and 
removes the portion of overlap from each of the features. The fix can be applied 
to one or more selected Must Be Covered By Feature Class Of errors. 


 
 
4. Select the error highlighted below using the Fix Topology Error Tool  
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• Right click on the topology and select Merge.   Do Not use Create 
Feature (which will make new polygons) or Subtract (which will create 
slivers in the LC_Premade feature class). 


 
• Based on the underlying land cover, select the second feature on the list 


and click OK. 
 


 
 


• Validate the Entire Topology again to make sure we fixed the 
problem. 


 
5. Next, select the large overlapping error as shown below.  We need to make 


sure only 1 polygon exists. 
 


  
 
 


• Right click and choose Create Feature.  This forces 2 simultaneous 
actions: 1) it subtracts the shape from the underlying polygon and 2) it 
creates a new feature in the same location. 


 
• Identify on the new feature.  You will notice the attribute has been lost 


since the Create Feature removes the existing and replaces it with a new 
polygon.  You can attribute the new polygon to Forest. 
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• Validate the Entire Topology again to make sure we fixed the problem. 
 


• Stop editing and save edits. 
 
 


6. If time permits:  Using the skills learned in this exercise; restart editing and 
continue fixing any remaining topological errors.  Remember to right-click on the 
Acreage field and Calculate the Geometry to generate the correct acres.  It’s 
not automatic. 
 
 


 
  


 


Digitizing and Topology 17 







Maldives GIS Training                                                                                   2013 
U.S. Fish and Wildlife Service                              National Conservation Training Center 
 


 


Digitizing and Topology 18 








GIS Data Development and Management                                                                               2014 
U.S. Fish and Wildlife Service                        National Conservation Training Center 
 


Agenda 


January 27-30, 2014 


 


 


 


 


Times Monday Tuesday Wednesday Thursday 


9:00-9:30 
Class Overview  


Review Review and 
Wrap-up 


9:30-10:30 Geodatabase 
Design 


 
&  
 


Metadata 


Geodatabase 
Tables Spatial 


Reference Open Lab 


 10:30-11:45 


11:45-1:30 Prayer and Lunch 


1:30-2:30 Acquiring 
Spatial Data 


 
Digitizing and 


Topology Sampling 
Design 


3:00-3:30 Prayer and Break 


3:30-4:30 


Managing 
Legacy Data 


 


Sampling 
Design 


Digitizing and 
Topology 


4:30-6:00 Open Lab 


Agenda                                                                                      1 
 







GIS Data Development and Management                                                                               2014 
U.S. Fish and Wildlife Service                        National Conservation Training Center 
 
 


Agenda                                                                                      2 
 








GIS Data Development and 
Management 


 
January 27-30, 2014 


 
Male, Republic of Maldives 


 
 


Offered by: 
 


 The U.S. Fish and Wildlife Service National Conservation Training 
Center and the U.S. Department of Interior International Technical 


Assistance Program 


 
In Cooperation with the Maldives Environmental Protection Agency 


  
 
 


  







Contributors 
 
 


Eric Kelchlin - Instructor 
U.S. Fish and Wildlife Service 
National Conservation Training Center 
Phone: +1 (304) 876-7453 
eric_kelchlin@fws.gov  
http://nctc.fws.gov/  
 
Dan Polhemus – Maldives Project Advisor 
U.S. Fish and Wildlife Service 
Coastal Conservation Program 
Honolulu, HI 
Phone: +1 (808) 792-9400 
dan_polhemus@fws.gov  
 
Marc Weitzel – ITAP Senior Advisor 
U.S. Department of the Interior 
International Technical Assistance Program 
Phone: +1 (805) 671-9746 
Mobile: +1 (805) 223-0385 
www.doi.gov/intl/itap 
 
Rifath Naeem – Maldives Liaison 
Environmental Protection Agency 
Male', Republic of Maldives, P.O Box: 20329 
Phone: (960) 333-5949, Fax: (960) 333 5953 
www.epa.gov.mv 



mailto:eric_kelchlin@fws.gov

http://nctc.fws.gov/

mailto:dan_polhemus@fws.gov

http://www.doi.gov/intl/itap

http://www.epa.gov.mv/






GIS Data Development and Management                                                                                              2014 
U.S. Fish and Wildlife Service                              National Conservation Training Center 
 


Table of Contents 
 
 


Exercise 1 – Establishing Spatial Reference…………………………………… Tab 1 


Exercise 2 – Acquiring Spatial Data ……………………….………….………… Tab 2 


Exercise 3 – Geodatabase Design for Legacy Data…………………………... Tab 3 


Exercise 4 – Geodatabase Design for Project Specific Data Collection…... Tab 4 


Exercise 5 – Creating, Importing and Exporting Metadata…………………... Tab 5 


Exercise 6 – Sampling Design…………….………………………………………. Tab 6 


Exercise 7 – Creating a Relational Geodatabase from a Messy Dataset..… Tab 7 


Exercise 8 – Creating a Land Cover Layer with Topology Rules…..………. Tab 8 


  


  


  


  


  


Table of Contents                                                                                      1 
 







GIS Data Development and Management                                                                                              2014 
U.S. Fish and Wildlife Service                              National Conservation Training Center 
 
 


Table of Contents                                                                                      2 
 





